
Design Guide: TIDA-010257
基于 Vienna 整流器的 10kW 三相功率因数校正参考设计

说明

高功率三相功率因数校正应用（例如家用电器、电动汽

车 (EV) 充电器和通信电源整流器）中使用了 Vienna 
整流器电源拓扑。整流器的控制设计可能很复杂。本设
计指南使用 C2000™ 微控制器 (MCU) 对功率级的控制

方法进行了说明。该设计还可基于 GUI 实现对 Vienna 
整流器的监测和控制。可供此设计使用的硬件和软件可
帮助您缩短产品上市时间。

资源

TIDA-010257 设计文件夹

TMS320F2800137、TMCS1123 产品文件夹

AMC1350、UCC5350 产品文件夹

UCC28750、LM25180 产品文件夹

ISOTMP35、ISO6721 产品文件夹

TPS54202、TLV76133 产品文件夹

请咨询我司 TI E2E™ 支持专家

特性

• 三相输入 380V、400VL-L、50/60Hz，输出 650V 
直流（标称值），10kW

• 40kHz 脉宽调制 (PWM) 开关

• 峰值效率大于 98%
• 满负载时的总谐波失真 (THD) 小于 1.5%
• 提供适用于 F280013x 的软件

• 基于 UART GUI 监测和控制 Vienna 整流器

应用

• 空调室外机
• 热泵
• 电动汽车充电基础设施
• 通信电源整流器
• 工厂自动化和控制
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1 系统说明

工业应用中以高功率运行的设备使用三相电源。为了提高电网电力质量并降低消耗的谐波电流，需要使用功率因

数校正，因为许多前向负载是直流电。例如商用空调、EV 充电器。

虽然用于有源三相功率因数转换的拓扑非常之多，但 Vienna 整流器仍然颇受青睐，因为它以连续导通模式 

(CCM) 运行，具有固有的多级开关（三级），并且可以降低功率器件上的电压应力。Vienna 整流器通常会使用基

于迟滞的控制器。直到最近，基于正弦三角的 PWM 才被用于 Vienna 整流器控制。该控制的设计可能非常具有挑

战性。Vienna 整流器具有多种变体，图 1-1 显示了该设计中选用的 Vienna 整流器变体以及所检测的主要电压和

电流。
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图 1-1. 实施的 Vienna 整流器变体

此设计指南实施了 Y 连接 Vienna 整流器。此设计旨在举例说明如何使用 C2000 MCU 控制 Vienna 整流器并对不

同环路进行调优。
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1.1 术语

PWM 脉宽调制

FET、MOSFET 金属氧化物半导体场效应晶体管

IGBT 绝缘栅双极晶体管

HVAC 暖通空调

RMS 均方根

PLL 锁相环

1.2 主要系统规格

表 1-1 详细说明了三相 Vienna 整流器主要电源规格。

表 1-1. 主要系统规格

参数 规格

输入电压 (VIN)

• 交流 208VRMS VL-L 或 120VRMS L-N，60Hz
或

• 交流 380VRMS VL-L 或 220VRMS L-N，50Hz

输入电流 (IIN) • 16A RMS（最大值）

输出电压 (VOUT) • 650V 直流母线（标称值）

输出电流 (IOUT) • 绝对 RMS 最大 16A，脉冲最大 29A

额定功率 • 三相 380VRMS 时 10kW

电流 THD
• 10kW 负载时 < 1.5%
• 2.5kW 负载下 < 5%

效率 峰值 98%

初级滤波电感器 31A 偏置电流下为 355µH

输出电容 940µF

PWM 开关频率 40kHz

!
警告

TI 建议，该参考设计 仅可在实验室环境中运行，不应将该电路板作为成品 供一般消费者使用。

TI 建议，该参考设计仅可由熟悉处理高压电子和机械部件、系统及子系统所存在相关风险的 合格工程师和

技术人员 使用。

电路板中存在可接触到的高电压 。如电路板的电压和电流处理不当或施加不正确，则可能导致电击、火灾

或伤害事故。使用该设备时应特别小心，并采取相应的保护措施，以避免伤害自己或损坏财产。
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!
小心

请勿在无人照看的情况下使该参考设计通电。 

高电压！ 电路板中存在可接触到的高电压 。可能发生电击。如电路板的电压和电流处理不当，则可能导致

电击、火灾或伤害事故。使用该设备时应特别小心，并采取相应的保护措施，以避免伤害自己或损坏财

产。为安全起见，强烈建议使用具有过压和过流保护功能的隔离式测试设备。

TI 认为在对电路板通电或进行仿真之前，用户有责任确认其已明确并理解电压和隔离要求。 通电后，请勿

触摸该参考设计或与该参考设计相连的元件 。

表面高温！接触可致烫伤。请勿触摸！

电路板上电后，某些元件可能会达到 55°C 以上的高温。由于存在高温，在使用过程中或使用刚结束时，用

户不得触摸电路板。

2 系统概述

2.1 方框图

图 2-1 显示了该设计中选用的 Vienna 整流器的方框图以及所感应的主要电压和电流。
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图 2-1. 方框图
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2.2 设计注意事项

2.2.1 控制系统设计原理

本节介绍控制系统设计原理

2.2.1.1 PWM 调制

图 2-2 显示了 Vienna 整流器的简化单相图。要控制该整流器，需要对占空比进行控制，以直接调节电压 vxiN。也

就是说，如果软件变量 Duty 设置为 1，则通过始终禁止打开 Q1 和 Q2 开关并将电感器通过桥式二极管连接至直

流母线，从而让 vxiN 成为可能的最高电压。同样，如果 Duty 设置为 0，则会对 PWM 进行调制，使得 Q1 和 Q2 
始终保持导通，让 vxiN 连接至直流母线的中点（其值为零），从而令其成为开关周期内可能的最低电压。
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图 2-2. Vienna 整流器的单相图
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图 2-3 显示了详细的 PWM 配置。
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图 2-3. Vienna 整流器详细 PWM 调制方案
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2.2.1.2 电流环路模型

要了解电流环路模型，应首先仔细查看电感器电流。在图 2-4 中，为连接到开关 Q1 和 Q2 的 PWM 调制器提供了

占空比 D。记住这一点，请参阅方程式 1：

VxiN = D × Vbus2 (1)

备注

当 D 设置为 1 时，所有开关关闭，当 D 为 0 时，所有开关打开，这会将电感器连接至 M 点。

要调制流经电感器的电流，应使用 Q1 和 Q2 开关的占空比控制调节电压 vxiN。假设电流的方向沿从交流线路到整

流器的方向为正并使用直流母线前馈和输入交流电压前馈，同时假设电网的阻抗相当小。电流环路可简化为如图 

2-4 所示，并且可以将电流环路受控体模型表达为方程式 2 所示。

Hp_i = iLi*D = 1Kv_gain × Ki_gain × Ki_fltr × Gd × 1Zi (2)

其中

• Kv_gain 是总线和交流输入最大感应电压的倒数，即 1/Vmax_sense。假设交流电压最大感应值和直流母线电压最

大感应值相等。
• Ki_gain 是最大交流感应电流的倒数。

• Ki_fltr 是从电流传感器连接到 ADC 引脚的 RC 滤波器的响应。

• Gd 是与 PWM 更新和数字控制相关联的数字延迟。

• iLi * 是电流命令，iLi 是实际电感器电流。

• Vbus/2 是某一输出总线电容器上的电压。

• Zi 是包含电感 Li 和电阻 Ri 的电感器的阻抗。

• Hp_i 是数字控制器 Gi 控制的电流环路受控体。

• viN 是输入端的瞬时交流电压。

+
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D
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+
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图 2-4. 电流环路控制模型

备注

由于电流环路被视为对电压 vxiN 进行调节，因此在参考上的相应位置使用了负号。要增大电流，必须降

低 vxiN，因此在图 2-4 中，将基准电压和电压反馈标记了“+”号。该电流环路模型用于调节电流补偿

器。该电流环路使用了一个简单比例控制器。会对比例增益进行调节，以确保系统稳定。
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2.2.1.3 直流母线调节环路

假设直流母线调节环路提供基准电源。该环路除以线电压 RMS 的平方，可得出电导率，然后再乘以线电压，以提

供瞬时电流命令。

通过围绕运行点对方程式 3 进行线性化来形成直流母线调节环路的小信号模型：

iDCvbus = 3nvNrmsiNrms iDC = 3n V−NrmsV−bus iLi (3)

对于电阻负载，总线电压与电流相关，如方程式 4 中所示。

Vbus = RL1 + sRLCo iDC (4)

可以画出直流电压调节环路模型，如图 2-5 中所示。施加了额外的 Vbus 前馈，以使控制环路独立于总线电压，因

此总线控制的受控体模型可表达为方程式 5 所示。Hp_bus = Hload × N × Ki_gain × Kv_gain × Kv_flt (5)

其中

• Hp_bus 是数字控制器 Gv 控制的电压环路受控体。

• Gv 的输出是功率基准 Po *
• vbus * 是电压命令和电压基准，vbus 是实际总线电压。

• Co 是输出电容器，RL 是负载电阻。

借助图 2-5，为该电压环路设计了一个比例积分器 (PI) 补偿器。由于该环路的带宽在稳态下与 THD 相冲突，因此

该环路保持在较低水平。

[
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图 2-5. 直流电压环路控制模型
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此外，还使用了非线性 PI 环路来降低阶跃负载变化时产生的瞬态。图 2-6 显示了在该设计中实现的非线性 PI 环
路的结构。

Uv

Umax

K2

Ev

E1

K1E2

Umin = 0

Kp = K1, for E(n)<E1 and E(n)>E2

Kp = K2, for E(n)<E1 and E(n)>E2

图 2-6. 电压控制器的非线性 PI 环路

2.2.1.4 直流电压平衡控制器

在 Vienna 整流器中，针对输出电压总线使用了一个分裂电容器。这些电容器上的电压不会自行保持必要的平衡，
因此添加了直流平衡控制器环路。该环路可对失调电压进行调制，并将其添加至占空比，因此对流经中点的电流

进行调制，以平衡分裂电容器上的电压。

针对直流母线平衡控制器使用了简单比例增益，其平衡环路的输出可通过方程式 6 计算得出。Gs_out = Vbus_PM− Vbus_MN × Gs_gain_Kp (6)
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2.3 主要产品

2.3.1 TMS320F280013x

TMS320F280013x (F280013x) 是 C2000™ 实时微控制器系列的可扩展、超低延迟器件，旨在提高电力电子产品

的效率。实时控制子系统基于 TI 的 32 位 C28x DSP 内核，可针对从片上闪存或 SRAM 运行的浮点或定点代码提

供 120MHz 的信号处理性能。三角函数加速器 (TMU) 进一步增强了 C28x CPU 的性能，从而加快了对实时控制

系统关键的常用算法的速度。F280013x 支持高达 256KB (128KW) 的闪存。高达 36KB (18KW) 的片上 SRAM 也
可用于补充闪存。高性能模拟块集成在 F280013x 实时微控制器 (MCU) 中，并与处理单元和 PWM 单元紧密耦

合，从而提供出色的实时信号链性能。14 个 PWM 通道可控制从三相逆变器到功率因数校正的各种功率级，以及

其他先进的多级电源拓扑。

2.3.2 UCC5350

UCC53x0 是单通道隔离式栅极驱动器系列，旨在驱动 MOSFET、IGBT、SiC MOSFET 和 GaN FET 
(UCC5350SBD)。UCC53x0S 提供分离输出，可分别控制上升和下降时间。UCC53x0M 将晶体管的栅极连接到内

部钳位，以防止米勒电流造成假接通。UCC53x0E 的 UVLO2 以 GND2 为基准，以获取真实的 UVLO 读数。

UCC53x0 采用 4mm SOIC-8 (D) 或 8.5mm SOIC-8 (DWV) 封装，可分别支持高达 3kVRMS 和 5kVRMS 的隔离电

压。凭借这些各种不同的选项，UCC53x0 系列成为电机驱动器和工业电源的理想之选。与光耦合器相比，
UCC53x0 系列的器件间偏移更低，传播延迟更小，工作温度更高，并且 CMTI 更高。

2.3.3 AMC1350

AMC1350 是一款隔离式精密放大器，此放大器的输出与输入电路由抗电磁干扰性能极强的隔离层隔开。该隔离栅

经认证可提供高达 5kVRMS 的增强型电隔离，符合 VDE V 0884-11 和 UL1577 标准，并且可支持最高 1.5kVRMS 
的工作电压。该隔离栅可将系统中以不同共模电压电平运行的各器件隔开，并保护低压侧免受可能有害的电压冲

击。AMC1350 的高阻抗输入经过优化，可连接到高阻抗电阻分压器或其他具有高输出电阻的电压信号源。出色的

精度和低温漂支持在 –40°C 至 +125°C 的工业级工作温度范围内，在直流/直流转换器、变频器、交流电机和伺

服驱动器应用中进行精确的交流和直流电压检测。

2.3.4 TMCS1123

TMCS1123 是一款电隔离霍尔效应电流传感器，具有业界出色的隔离功能和精度。该器件还提供与输入电流成正

比的输出电压，且在所有灵敏度选项下均具有出色的线性度和低漂移。具有内置漂移补偿功能的精密信号调节电

路能够在没有系统级校准的情况下，在温度和寿命范围内实现小于 1.4% 的最大灵敏度误差，或在一次性室温校准

的情况下，实现小于 1% 的最大灵敏度误差（包括寿命和温度漂移）。

交流或直流输入电流流经内部导体，所产生的磁场可由集成式片上霍尔效应传感器进行测量。无磁芯结构消除了

对磁集中器的需求。差分霍尔传感器可抑制外部杂散磁场产生的干扰。低导体电阻将可测量电流范围提高至 
±96A，同时更大程度地降低功率损耗并降低散热要求。绝缘能够承受 5kVRMS，加上最小 8.1mm 的爬电距离和间

隙，可提供高达 1.3kVDC 的可靠寿命增强型工作电压。集成式屏蔽可提供出色的共模抑制和瞬态抗扰度。

固定的灵敏度允许器件使用单个 3V 至 5.5V 的电源运行，因此消除了比例式误差并提高了电源噪声抑制能力。

2.3.5 UCC28750

UCC28750 是一款高度集成且具有连续导通能力的电流模式 PWM 控制器，针对使用光耦合器的高性能、低待机

功耗和具有成本效益的离线反激式转换器应用进行了优化。在轻负载条件下，该器件会进入频率折返和突发模

式，从而提高轻负载效率。UCC28750 中使用的突发模式算法控制最低有效开关频率，以防在轻负载条件下出现

可闻噪声。频率抖动可提高 EMI 性能，并在正常、频率折返和功率提升运行中有效。

UCC28750 提供多种保护功能，只需极少外部元件即可实现稳定的转换器设计。输出过功率保护 (OPP) 和逐周期

过流限制可保护负载和功率级元件免受电应力的影响。过压和欠压锁定（OVLO 和 UVLO）可防止在不必要的输

入条件下进行开关。FLT 引脚提供线路欠压检测和保护，或者外部过热和过压保护，具体取决于器件型号。无论

何种器件型号，FLT 引脚还用于通过外部控制（下拉至地）禁用器件。

2.3.6 LM25180

LM25180 是一款初级侧调节 (PSR) 反激式转换器，在 4.5V 至 42V 的宽输入电压范围内具有高效率。从初级侧反

激式电压采样隔离输出电压数据，无需使用光耦合器、电压基准或变压器的第三绕组进行输出电压稳压。
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高集成度可实现简单可靠的高密度设计，其中只有一个元件穿过隔离层。通过采用边界导电模式 (BCM) 开关，可

实现紧凑的磁设计以及优于 ±1.5% 的负载和线路调节性能。集成的 65V 功率 MOSFET 能够提供高达 7W 的输出

功率并提高应对线路瞬变的余量。

2.3.7 ISOTMP35

TI ISOTMP35 是业界先进的隔离温度传感器 IC，集成了隔离栅，可承受高达 3000VRMS 电压，具有一个模拟温度

传感器，可在 –40°C 至 150°C 范围内实现 10mV/°C 的斜率。通过这种集成，可将传感器与高压热源（例如，高

压 FET、IGBT 或高压接触器）置于同一位置，而无需昂贵的隔离电路。与通过将传感器放置在较远位置来满足隔

离要求的方法相比，直接接触高压热源还可提供更高的精度和更快的热响应。由 2.3V 至 5.5V 的非隔离式电源供

电，ISOTMP35 可轻松集成到高压平面没有子稳压电源的应用中。集成隔离栅满足 UL 1577 的要求。表面贴装封

装（7 引脚 SOIC）可提供从热源到嵌入式热传感器的出色热流，更大限度地降低热质量并提供更精确的热源测

量。这降低了对耗时热建模的需求，并通过减少由于制造和组装而产生的机械变化来提高系统设计裕度。

ISOTMP35 AB 类输出驱动器提供强大的 500μA 最高输出，可驱动高达 1000pF 的容性负载，并可直接连接到模

数转换器 (ADC) 采样保持输入端。

2.3.8 TLV76133

TLV761 是一款线性稳压器，在传统 x1117 稳压器（TLV1117 或 LM1117）的基础上改进了功能，具有更严格的输

出精度和低静态电流 (IQ)，可降低待机功耗。TLV761 与其他采用 SOT-223、TO-252 封装且具有固定输出的稳压

器引脚对引脚兼容。TLV761 输入电压范围为 2.5V 至 16V，提供的输出电压范围为 0.8V 至 13V，可支持各种应

用。TLV761 的宽带宽 PSRR 性能通常在 1kHz 时大于 60dB，在 1MHz 时大于 40dB，因此有助于减小上游直流/
直流转换器的开关频率，并更大限度地减少后置稳压器滤波。此外，TLV761 还具有内部软启动功能，可减少启动

期间的浪涌电流，这有助于通过尽可能减少输入电容来节省设计空间和成本。TLV761 具有折返电流限制，可在高

负载电流故障或短路事件期间限制器件的功率耗散。

2.3.9 TLV9062

TLV9061（单通道）、TLV9062（双通道）和 TLV9064（四通道）是低压、1.8V 至 5.5V、运算放大器，具有轨

到轨输入和输出摆幅能力。这些器件具有高成本效益，适用于需要低压运行、小型封装和高容性负载驱动能力的

应用。虽然 TLV906x 的容性负载驱动能力为 100pF，但电阻式开环输出阻抗便于在更高的容性负载下更轻松地实

现稳定。此类运算放大器专为低工作电压（1.8V 至 5.5V）而设计，性能规格类似于 OPAx316 和 TLVx316 器
件。

TLV906xS 器件具有关断模式，允许放大器切换至典型电流消耗低于 1µA 的待机模式。TLV906xS 系列有助于简

化系统设计，因为该系列具有稳定的单位增益，集成了 RFI 和 EMI 抑制滤波器，而且在过驱条件下不会出现相位

反转。针对所有通道型号（单通道、双通道和四通道）提供微型封装（如 X2SON 和 X2QFN）以及业界通用封装

（如 SOIC、MSOP、SOT-23 和 TSSOP）。

2.4 硬件设计

2.4.1 电感器设计

输入电感器 (Li) 会过滤掉开关频率谐波。除其他因素之外，电感器设计还与电流纹波计算值和内核为承受计算出

的电流纹波而选用的材料相关。图 2-7 显示了一个开关周期波形内逆变器输出电压 vi 与电感器电流的关系。
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图 2-7. 电流纹波计算

电感器上的电压由 V = Li(di/dt) 给出。对于 Vienna 整流器，请参阅方程式 7。Vbus2 − Vin = Li × ∆ ippD′ × Ts (7)

其中

• Ts = 1/Fsw 是开关周期

• D' 是开关处于接通状态的占空比

对于控制设计，假设 D 是电感器的另一个端子处的电压，它与 D' 的关系为 D' = 1 - D。在交流波形中的任何时刻

对电流纹波的重新排列根据方程式 8 得出。

∆ ipp = D′ × Ts × Vbus2 − VinLi (8)

现在，假设调制指数为 ma，则占空比可由 D' = ma*sin(ωt) 给出，假设 Vin = D' × (Vbus/2)，则可以推导出 方程式 

9。

∆ ipp = Vbus2 × Ts × ma × sin ωt × 1 −masin ωtLi (9)

通过方程式 9，可以清楚地看到，峰值纹波是一个因数，其中输入交流电具有正弦波形。

要获取相对于时间使公式差异化的最大值，请使用方程式 10。

d ∆ ippdt = K cos ωt 1 − masin ωt − masin ωt × cos ωt = 0 (10)

该公式提供了 sin(ωt)=1/(2 × ma) 中存在的最大纹波，替换该值，可以推导出方程式 11。

∆ ippmax = Vbus2 × Ts4 × Li Li = Vbus24 × Fsw × ∆ ippmax (11)

得到这些值后，可以选择相应的内核以及符合该电感值的电感器。
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2.4.2 总线电容器选择

总线电容器负责消除直流电压上可能由正弦电流消耗导致的纹波。电容器值和直流母线纹波之间的关系由方程式 
12 给出。

C = 13 Pac4 × f × V2 − V − ∆V 2 (12)

该公式用于选择最小直流母线电容值。

备注

方程式 12 中的计算可以得出电容器的超裕度设计。电容器大小调整更依赖于负载及其消耗的电流的性

质。对于三相 PFC，电源纹波相当小，因为输入始终具有到达输出的路径。方程式 12 仅用作参考，请

注意这会导致超裕度设计。

2.4.3 输入交流电压感测

首先，使用以 Y 方式连接的电阻器网络以及某个用于实现稳定性的电容构建虚拟中性点。在该设计中，控制器保

持位于冷侧，因此使用隔离式放大器 AMC1350 来处理 VL-N’ 电压，如图 2-8 中所示。由于在设计 AMC1350 时
考虑了用于电流检测应用的低阻抗源，因此输入差动电阻在总增益计算中扮演非线性角色。因此，在版本级别一

中必须完成最终校准，并且必须根据校准调节最大交流电压范围。
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图 2-8. 输入交流电压感测

2.4.4 输出直流母线电压检测

类似地，使用 AMC1350 和 TLV9062 检测在两个电容器之间进行分摊的直流母线电压，如图 2-9 中所示。由于精

确度在直流母线电压检测中很重要，因此需要执行进一步的偏移校准和增益调节。
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图 2-9. 总线电压感测
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2.4.5 辅助电源

辅助电源旨在提供 15V 电压轨。该电源由 U7 UCC28750 和一个高压 MOSFET Q8 控制。3.3V 电压轨由 LDO 
U11 TLV76133 和随后的直流/直流降压电源产生。该设置有助于降低 LDO 上的压降和发热，LDO 还提供准确且

稳定的 3.3V，可用作 ADC 的电压基准。图 2-10 展示了该电路。
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图 2-10. 辅助电源

2.4.6 隔离式电源

此参考设计需要五个隔离式低压轨来支持交流输入电压检测、直流输出电压检测以及让 IGBT 栅极驱动器正常工

作。基于 LM25180 的简单低电压反激式电源设计用于生成这些隔离式电压轨。图 2-11 展示了该电路。
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图 2-11. 隔离式电源

2.4.7 电感器电流感应

TMCS1123 霍尔效应传感器用于检测流经电感器的电流。霍尔效应传感器具有内置的 1.65V 失调电压，ADC 可以

直接测量该失调电压。图 2-12 展示了电路。
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图 2-12. 使用霍尔效应传感器进行电流检测

2.4.8 栅极驱动器

图 2-13 展示了此参考设计中用于驱动 IGBT 的 UCC5350MC 器件。此栅极驱动器具有 10A 拉电流和灌电流以及

米勒钳位。大电流驱动可以加快 IGBT 的上升和下降时间，还可以减少开/关转换期间的功率损耗。
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图 2-13. 栅极驱动器

2.4.9 隔离式温度感测

图 2-14 展示了用于检测功率器件温度的 ISOTMP35 隔离式温度传感器。由于 TSENSE 焊盘是隔离的，因此可以

与功率器件位于同一覆铜上。由于该电压是线性的，因此环境温度也很容易通过输出电压计算出来。
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图 2-14. 隔离式温度感测

2.4.10 过流和过压保护 (CMPSS)

大多数电力电子转换器需要过流和过压事件保护。对于该设计，需要用到多个比较器，并且必须针对跳闸生成基

准，如图 2-15 所示。

PWM Trip

+

-

Filtering

+

-

Itrip-Hi

Itrip-Lo

Iinv_fdbk

Comparators

+

-

Itrip-Lo

3.3 V

+

-

Itrip-Hi

3.3 V

Trip References Generation

图 2-15. 使用比较器和基准生成器为 PWM 生成跳闸

在使用 TMS320F280013x 等 C2000 MCU 时，避免了所有这些电路，这些 MCU 具有作为 CMPSS 一部分的片上

窗口比较器，它们在内部连接到 PWM 模块，可以实现 PWM 快速跳闸。该器件可在最终应用中节省布板空间并

且具有成本效益，因为可以通过使用片上资源避免额外的组件，如图 2-16 中所示。
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ADC Pin on C2000 MCU

ADC

Comparator Subsystem

DACLVAL

DACHVAL

+

±

+

±

COMPH

COMPL

To Pwm Trip

图 2-16. 用于过流和过压保护的比较器子系统 (CMPSS)
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3 硬件、软件、测试要求和测试结果

本节介绍硬件、软件和测试结果。

3.1 硬件要求

3.1.1 入门硬件

本节详细介绍了参考设计电路板及软件测试和验证所需的设备、测试装置和过程说明。

3.1.1.1 电路板概述

参考电路板具有可实现完整三相 Vienna PFC 系统的功能组。下面的列表显示了电路板上的功能块。图 3-1 展示

了电路板的顶视图和不同的块。表 3-1 显示了主要连接器及功能。

• 交流输入线路滤波器和继电器
• 升压电感器
• 桥和 IGBT
• 辅助电源和隔离电源
• DSP，F2800137
• 电压检测和栅极驱动器
• IGBT 栅极驱动器

图 3-1. 电路板概述
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表 3-1. 主要连接器和功能

连接器名称 功能

J1、J2、J3 三相交流输入的火线

J5 三相交流输入的零线

J7 三相交流输入的地线

J4 输出直流母线正极

J6 输出直流母线中点

J8 输出直流母线负极

J9 用于 GUI 的隔离式通用异步接收器/发送器 (UART)

J10 15V、1A 外部电源

J11 用于调试的 cJTAG

J12 散热器热敏电阻

3.1.1.2 测试设备

确保以下设备已准备好进行测试：

1. 从 0VAC 到 400VAC 的 10kW 交流电源 L 到 L，或从 208VAC 到 400VAC L 到 L 的电网电源

2. 10kW 直流负载，负载可更改。

3. 15V、1A 电源适配器

4. USB 转 UART 适配器和电缆

5. 万用表

6. 三相功率分析仪

7. 数字示波器

3.2 软件要求

3.2.1 入门 GUI

该参考设计提供了源代码，因此设计人员可以直接调试固件，如节 3.2.2 中所述。但是，软件调试需要更多时间。

为了加快开发速度，提供了一个基于 UART 的 GUI 软件，以帮助快速控制电路板并观察电路板工作状态。本节介

绍如何使用 UART GUI。

当将主机 PC 在 J9 处连接到此参考电路板时，由于 J9 是隔离式 UART 端口，因此 UART 端口需要由外部 5V 或 

3.3V 电压轨供电。

3.2.1.1 测试设置

图 3-2 展示了用于使用 GUI 进行测试的硬件连接。按照以下步骤设置硬件：

1. 通过 USB 转 UART 适配器将 J9 上的 GND、TX、RX 和 3.3V 或 5V 至 VCC_ISO 连接到主机 PC。

2. 将交流输入电缆连接到 J1、J2 和 J3。J5 和 J7 可以连接，也可以保持断开。

3. 将直流输出电缆连接到 J4 和 J8，设置为空载。

4. 连接万用表、示波器探头和其他测量设备，以探测或分析各种信号和参数。

5. 在笔记本电脑上运行 GUI 软件。
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图 3-2. GUI 的硬件设置

3.2.1.2 GUI 软件概述

任何 UART 终端 GUI 软件均可用于主机 PC 和参考设计电路板之间的通信。图 3-3 展示了一个 GUI 软件，该软

件具有显示窗口，用于显示参考设计电路板报告的工作状态；在 HEX 模式下，该 GUI 软件还可以向电路板发送

命令。支持的波特率是 115200。

报告的电路板工作状态包括交流输入电压、直流输出电压、交流输入电流、交流输入功率因数、功率器件温度、
散热器温度和通电时间。这些数据以 ASCII 模式显示。

命令如下：

• 0x11 是用于启动 PFC 的命令

• 0x22 是用于停止 PFC 的命令

• 0x33 是用于清除错误的命令

图 3-3. GUI 软件概述

3.2.1.3 使用 GUI 进行测试的过程

按照以下步骤使用 GUI 来测试参考设计：

1. 使用 USB 转 UART 适配器将笔记本电脑连接到 J9。
2. 将交流电源（208AC 至 400VACL-L）连接到 J1、J2 和 J3。J5 和 J7 可以连接，也可以断开。

3. 将直流负载连接到 J4 和 J8，设置为空载。
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4. 运行 GUI 软件，选择正确的 UART 端口并将波特率设置为 115200bps。
5. 给电路板上电，等待 D25 LED 指示灯闪烁。

6. 等待继电器闭合。

7. 检查 GUI，由于 PFC 未启动，因此 380VAC 输入时直流输出电压约为 530VDC。

8. 发送 0x11 命令以启动 PFC，直到空载条件下的直流输出电压约为 680VDC。

9. 逐步增加负载，直到直流输出电压约为 650VDC（当负载 > 500W 时）。在有负载期间检查交流输入电流、直

流输出电压和温度。图 3-4 显示了 380VAC、650VDC、9kW 下的波形。

备注

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-4. 380VAC、650VDC、9kW 下的波形

10. 逐步卸载电路板，直到空载。

11. 发送 0x22 命令以停止 PFC。

12. 若要使系统安全停止，请将输入交流电压降至零。

小心
该参考设计使用电解电容器。在没有外部负载的情况下，电容器的放电速度非常慢。始终注意直流母

线电压。

直流母线上的负载可以加速放电；否则，需要等待很长时间才能让直流母线降至零。
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3.2.2 固件入门

适用于 C2000™ 微控制器的 DigitalPower 软件开发套件 (SDK) 中提供了适用于该设计的软件。

备注

TMS320F2800137 实时微控制器支持该设计的固件。

3.2.2.1 在 Code Composer Studio™ 中打开项目

要开始使用该软件，请执行以下操作：

1. 从 Code Composer Studio™ (CCS) 集成开发环境 (IDE)™ 工具文件夹下载 Code Composer Studio IDE 并进

行安装。建议使用版本 20.0.0 或更高版本。

2. 下载并安装适用于 C2000 微控制器的 DigitalPower 软件开发套件 (SDK)
3. 安装完成后，打开 CCS 并创建用于导入项目的新工作区，方法是点击 Project → Import CCS Projects，然后

浏览到 
<install_location>\C2000Ware_DigitalPower_SDK_5_03_00_00\solutions\TIDA-010257\

f280013x，然后点击项目名称并导入项目。

3.2.2.2 工程结构

图 3-5 显示了导入项目后 CCS 内的“Project Explorer”。

Project Name 

[Build Configuration]

Device Support Files

Board & Device Specific Files with Drivers 

for this solution

Solution Specific Files

Settings File generated 

Graph Prop File for populating the Graphs in 

CCS
XML Files generated by powerSUITE page (Do Not Modify)

Java Script File used by powerSUITE (Do Not Modify)

Target Configuration for debugger connection

Include File paths for different 

components in the project 

javaScript for populating the expressions window for 

different build levels

powerSUITE GUI Page

Main Function of the C project, ISR framework 

Digital Control Library Files

SFRA Files

CLA Files

图 3-5. 设计项目的“Project Explorer”视图

该项目包含一个在每个 PWM 周期中都会调用的中断服务例程，该例程称为 controlISR()，在其中执行控制算

法。除此之外，还有 A0-A3 和 B0-B3 后台任务，它们以轮询方式进行调用，可用于运行不要求绝对计时精度的缓

慢任务。将调用一个较慢的 10kHz 例程 tenkHzISR() 以用于检测，并运行一些需要计时精度的较慢任务。
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此设计指南中的软件以四个增量编译 (INCR_BUILD) 的方式进行组织。增量编译过程可以简化系统开发和设计。

• INCR_BUILD 1：开环检查

• INCR_BUILD 2：闭合电流环路

• INCR_BUILD 3：闭合电压和电流环路

• INCR_BUILD 4：闭合电压、电流和总线电容平衡环路

节 3.2.2.4.1 至节 3.2.2.4.4 中详细介绍了这些编译级别。

3.2.2.3 测试设置

图 3-6 展示了硬件模块。在开始每个编译级别测试之前，请完成以下测试设置步骤：

1. 将仿真器连接到 J9
2. 将交流电源连接到 J1、J2 和 J3，设置为 0V 输出

3. 将直流负载连接到 J4 和 J8，设置为 530Ω
4. 使用 UART 转 USB 适配器将 J9 连接到笔记本电脑。

5. 将 15V、1A 直流适配器连接到 J10

ia
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Probe

Three Phase 

AC Power Supply

(220VAC/380VAC, 

16A, 50/60Hz)

ib

ic
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J7
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15V DC, 

1A Power Supply

J4

J6
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Load

Power Resistor

VBUSP

VBUSM
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CCS

GUIJ9

J12

Differential 

Probe
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Probe
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Temperature 

Probe

Three 

Phase 

Power 
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图 3-6. 硬件模块
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3.2.2.4 运行项目

本节介绍编译级别 1-4 的固件调试。与代码中的实际名称不同，用户指南中提到的变量名是简化的。例如，
VIENNA_guiVbus_Volts 简化为 guiVbus。

3.2.2.4.1 INCR_BUILD 1：开环

电路板以开环模式运行（采用固定占空比）。占空比由 dutyPU_DC 变量控制。该编译版本会验证来自功率级的

反馈值检测以及 PWM 栅极驱动器的运行，从而确保没有硬件问题。此外，可以在该生成中执行输入和输出电压

感应校准。图 3-7 展示了该编译版本的软件结构。对以较慢的 ISR 运行的块进行了标记。其他块以快速 

controlISR 运行。

10 Khz ISR

1

2
3

v1Meas,

v2Meas, 

v3Meas

iL1Meas,

iL2Meas, 

iL3Meas

vBusMNMeas
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Read 

ADC 

and 

scale 

to PU

vBusMeas�

PWM

dutyPU_DC

duty1PU,

duty2PU,

duty3PU

+

+

+

Vdc

DLOG_4CH

input_ptr1 output_ptr1

size

trig_value

pre_scalar

DBUFF1

output_ptr2 DBUFF2

output_ptr3 DBUFF3

output_ptr4 DBUFF4

input_ptr2

input_ptr3

input_ptr4

.v

POWER_MEAS_SINE_
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threshold

.i

.acFreq

T=1 / f

图 3-7. 构建级别 1 控制软件图：开环项目
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3.2.2.4.1.1 设置、编译和加载项目

1. 打开 vienna_settings.h 文件，将 VIENNA_INCR_BUILD 设置为 1。
2. 在 Project Explorer 中，确保在 targetConfigs 下将正确的目标配置文件设置为“Active”（请参阅图 

3-5）。

3. 右键点击项目名称，然后点击 Rebuild Project，项目将会成功编译。

4. 点击 Run → Debug。这会启动调试会话。

5. 然后项目加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

3.2.2.4.1.2 设置调试环境窗口

1. 如需在“Watch”或“Expressions”窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台

对话框。在该控制台的右上角，点击 Open 按钮，然后浏览到位于项目文件夹内的 

setupdebugenv_build1.js 脚本文件。该脚本文件会采用调试系统所需的相应变量填充 Watch 窗口。点

击 Watch 窗口中的 Continuous Refresh 按钮 ( )，以启用持续更新控制器中的值。图 3-8 显示了 Watch 窗
口。

图 3-8. 版本级别 1 表达式视图
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2. 可以通过查看图形窗口中的数据来验证电流和电压测量值。这些值记录在较慢的 10kHz 例程中。转到 Tools 
→ Graph → DualTime，然后点击 Import 并指向项目文件夹中的 graph1.GraphProp 文件。该文件将填充 

Graph Properties 窗口。或者，可以如图 3-9 中所示输入值。验证输入值后，点击 OK 按钮。CCS 会显示两

个图形。点击这些图形上的 Continuous Refresh 按钮 ( )。还可以通过导入 graph2.GraphProp 文件添

加第二组图形。

图 3-9. 图形设置

3.2.2.4.1.3 使用实时仿真

实时仿真是一项特殊仿真功能，允许在 MCU 运行时更新 CCS 内的窗口。该功能不但允许更新图形和“Watch”
视图，还允许用户更改“Watch”或“Memory”窗口中的值，并在不停止处理器的情况下查看这些更改对系统的

影响。

1. 通过将鼠标悬停在水平工具栏中的按钮上并点击  按钮来启用实时模式。

2. 如果出现消息框，请选择 YES 以启用调试事件。这将把状态寄存器 1 (ST1) 的位 1（DGBM 位）置位为 0。
DGBM 是调试使能屏蔽位。当 DGBM 位设置为 0 时，内存和寄存器值将传递到主机处理器以更新调试器窗

口。
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3.2.2.4.1.4 运行代码（版本 1）

1. 点击  按钮运行工程。

2. 在“Watch”视图中，定期查看是否更新了 guiVbus 变量（“Expressions”窗口中的 

VIENNA_guiVbus_Volts）。如果值没有变化，则确保已启用实时模式并且已正确设置硬件。除非已验证更

新，否则不要执行进一步的操作。

备注
现在未通电，因此该值接近于零。

3. 将输入交流电压从 0VRMS 缓慢增大到 80VRMS L-N。

4. 验证电压检测：确保 guiVbus、guiVbusPM 和 guiVbusMN 显示正确的值。对于 80VRMS L-N，guiVbus 

接近 190V，图形函数可以显示波形，如图 3-10 中所示。guiVbusPM 和 guiVbusMN 变量都接近于 85V。代

码运行正弦分析仪模块，该模块计算电压和电流的 RMS 值。图 3-11 显示 guiVrms1、guiVrms2 和 

guiVrms3 值都接近于输入值，即 80VRMS。这就实现了对电路板的电压感应的验证。

图 3-10. 构建级别 1：显示测得的输出电压的图

图 3-11. 构建级别 1：显示测得的输入电压的图

www.ti.com.cn 硬件、软件、测试要求和测试结果

ZHCUCN4 – DECEMBER 2024
提交文档反馈

基于 Vienna 整流器的 10kW 三相功率因数校正参考设计 27

English Document: TIDUFB1
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUCN4
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUCN4&partnum=TIDA-010257
https://www.ti.com/lit/pdf/TIDUFB1


5. 验证电流检测：请注意 guiVrms1、guiVrms2 和 guiVrms3 变量，对于给定的测试条件，这些值接近于 

0.5A。此外，必须查看图形以验证电流测量。图 3-12 在图形上显示了电流。

图 3-12. 构建级别 1：显示测得的电流的图

6. 图 3-13 显示了输入电压和电流的示波器屏幕截图。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-13. 构建级别 1：PWM 跳闸时的示波器屏幕截图 Ia 和 Va (80VRMS L-N)
7. 为了验证 PWM 操作，首先将输入电压降至零，然后等待所有电压降至零。

8. 在“Expressions”视图中将 dutyPU_DC 设置为 0.5。
9. 通过向 clearTrip 写入 1 来清除 PWM 跳闸。

10. 缓慢增大输入电压并监视输入电流。占空比会提供升压操作。例如，当 VAC 为 80VRMS 时，在未启用开关的

情况下，guiVbus 将约为 190V；在启用开关的情况下，guiVbus 将上升至 380V。因此，guiVbusPM 和 

guiVbusMN 都高于输入电压最大值。
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11. 以下是该编译版本中所述的测试条件，当输入电压达到 80VRMS L-N 时，guiVbus 变量上升至大约 380V，
guiVbusPM 和 guiVbusMN 各自接近于 190V，并且电流接近于 1.1ARMS。“Expressions”视图显示如图 

3-14 所示。确保所有变量都是准确的，即以下变量：guiVrms1、guiVrms2、guiVrms3、guiIrms1、

guiIrms2、guiIrms3、guiPF1、guiPF2 和 guiPF3。如果任何变量不准确（如图 3-14 所示），则这意

味着检测电路存在硬件问题。

图 3-14. 构建级别 1：包含功率测量的“Expressions”视图

12. 图 3-15 显示了示波器屏幕截图。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-15. 构建级别 1：占空比为 0.5 的示波器屏幕截图 Ia 和 Va (80VRMS L-N)
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13. 该检查在基本层面上验证 PWM 驱动器和硬件连接。

14. 将输入电压降至零，然后等待总线电压降至零。

15. 至此结束对该构建的检查，成功完成该构建后，请验证以下事项：
a. 电压和电流检测以及缩放是否正确

b. controlISR 和 tenkHzISR() 变量中编译版本 1 代码的中断生成和执行

c. PWM 驱动器和开关

如果观察到任何问题，请仔细检查硬件，以消除任何编译问题等等。

16. 现在可以停止控制器，并终止调试连接。

17. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，使用工具栏上的 Halt 按钮 ( ) 或使用 Target → 

Halt 来暂停处理器。然后点击  图标，使 MCU 退出实时模式。最后，点击  按钮以对 MCU 进行复

位。
18. 点击 Terminate Debug Session (Target > Terminate all)，关闭 CCS 调试会话。

3.2.2.4.2 INCR_BUILD 2：闭合电流环路

在 BUILD 2 编译版本中，内侧电流环路是闭合的，也就是说，使用电流补偿器 Gi 控制电感器电流。对该电流补

偿器的输出应用了直流母线和输出电压前馈，以生成逆变器的占空比，如方程式 13 中所示。该操作可以简化电流

补偿器的受控体，并且可以使用比例 (P) 控制器来调节内侧电流的环路。我们已在节 2.2.1.2 中得出了电流环路的

模型。

duty1PU = iL1Meas − iL1Ref × Gi_GainKp + v1Measv BusHalfMeas (13)
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图 3-16 展示了该编译版本的完整软件图。
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图 3-16. 构建级别 2 控制软件图：闭合电流环路
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3.2.2.4.2.1 运行代码（版本 2）

1. 点击  按钮运行工程。

2. 首先在低电压下进行测试。因此，输入交流电压仅上升到 40VRMS (50Hz)。
3. 图 3-17 展示了输入电流和电压波形。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-17. 构建级别 2：PWM 跳闸时的示波器屏幕截图 Ia 和 Va (40VRMS L-N)
4. 通过在“Expressions”视图中更改 iLRef 变量设置电流基准。该变量设置为 0.02。
5. 通过将 clearTrip 变量设置为 1 来清除跳闸。
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6. 一旦清除跳闸，就会从输入消耗正弦电流，这证明电流环路的运行是正常的。图 3-18 显示了波形。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-18. 构建级别 2：iLRef = 0.02 时的示波器屏幕截图 Ia 和 Va (40VRMS L-N)
7. guiVbus 变量将接近于 230V，并且每相输入交流电流将接近于 1.07A。
8. 将输入交流电压缓慢增大至 120VRMS。在输入电压增大时，电路板使输入电流保持恒定。将输出电压增大至 

460V。图 3-19 显示了波形的外观。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-19. 构建级别 2：iLRef = 0.02 时的示波器屏幕截图 Ia 和 Va (120VRMS L-N)
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9. 现在，将电流基准 iLRef 增加至 0.05。观察总线电压变为 610V，输入电流变为大约 2.5A。图 3-20 显示了

波形。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-20. 构建级别 2：iLRef = 0.05 时的示波器屏幕截图 Ia 和 Va (120VRMS L-N)
10. 由于仅在补偿器中使用了一个比例增益，因此电流基准减去反馈误差绝不为零。请注意，消耗的电流会稍微偏

离基准。
11. 要使系统安全停止，请将输入交流电压降至零，并且观察 guiVBus 也降至零。

12. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，使用工具栏上的 Halt 按钮 ( ) 或使用 Target > 

Halt 来暂停处理器。接着，点击  按钮，使 MCU 退出实时模式。最后，将 MCU 复位 ( )。
13. 点击 Terminate Debug Session (Target > Terminate all)，关闭 CCS 调试会话。
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3.2.2.4.2.2 编译和加载项目以及设置调试

1. 打开 vienna_settings.h 文件，将 VIENNA_INCR_BUILD 设置为 2。
2. 右键点击项目名称，然后点击 Rebuild Project。这将成功编译项目。点击 Run（运行） → Debug（调试），

这将启动调试会话。对于双 CPU 器件，如果出现一个窗口，指示必须选择一个 CPU，则执行调试。在本例

中，选择“CPU1”。然后项目加载到器件上，同时 CCS 调试视图变为有效状态。代码在主例程开始时停

止。
3. 如需在“Watch”或“Expressions”窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台

对话框。在该控制台的右上角，点击 Open 浏览到位于项目文件夹内的 setupdebugenv_build2.js 脚本

文件。该文件将采用调试系统所需的相应变量填充 Watch 窗口。点击 Watch 窗口中的 Continuous Refresh 

按钮 ( )，以启用持续更新控制器中的值。图 3-21 展示了 Watch 窗口。

图 3-21. 构建级别 2：闭合电流环路表达式视图

4. 通过将鼠标悬停在水平工具栏中的按钮上并点击  按钮来启用实时模式。
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3.2.2.4.3 INCR_BUILD 3：闭合电压和电流环路

在该编译版本中，在内侧电流环路闭合的情况下，外侧电压环路是闭合的（在 BUILD 2 中设计）。图 3-22 展示

了该编译版本的软件图。
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图 3-22. 构建级别 3 控制图：使用内侧电流环路进行输出电压控制
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3.2.2.4.3.1 编译和加载项目以及设置调试

1. 打开 vienna_settings.h 文件，将 VIENNA_INCR_BUILD 设置为 3。
2. 右键点击项目名称，然后点击 Rebuild Project。这将成功编译项目。点击 Run（运行） → Debug（调试），

这将启动调试会话。对于双 CPU 器件，如果出现一个窗口，指示必须选择一个 CPU，则执行调试。在本例

中，选择“CPU1”。然后项目加载到器件上，同时 CCS 调试视图变为有效状态。代码在主例程开始时停

止。
3. 如需在“Watch”或“Expressions”窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台

对话框。在该控制台的右上角，点击 Open 以浏览到位于项目文件夹内的 setupdebugenv_build3.js 脚本文

件。该文件使用调试系统所需的合适变量来填充 Watch 窗口。点击 Watch 窗口中的 Continuous Refresh 按

钮 ( )，以持续更新控制器中的值。

图 3-23 展示了 Watch 窗口。

图 3-23. 构建级别 3：“Expressions”视图

4. 通过将鼠标悬停在水平工具栏中的按钮上并点击  按钮来启用实时模式。
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3.2.2.4.3.2 运行代码（版本 3）

1. 点击  按钮运行工程。

2. 将输入交流电压增大至 120VRMS VL-N 或 208VRMS VL-L，50Hz。
3. 直流电压基准通过变量 vBusRef 进行设置。该值设置为 1.0，在该设计中该值对应于 420V。
4. 通过将 clearTrip 变量设置为 1 来清除跳闸。然后总线电压将增大至 420V。
5. 可以通过在“Expressions”窗口中比较 vBusRef 和 vBusMeas 来验证闭环运行，如图 3-24 所示。

图 3-24. 构建级别 3：Vref = 1.0 时的“Expressions”窗口
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6. 图 3-25 显示输入电压和电流波形

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-25. 构建级别 3：Vref = 1.0 时的示波器屏幕截图 Ia 和 Va (120VRMS L-N)
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7. 现在逐步将 vBusRef 提高至 1.5，总线电压升至 630V，vBusRef 和 vBusMeas 变量出现在

“Expressions”窗口中，如图 3-26 所示。

图 3-26. 构建级别 3：Vref = 1.5 时的“Expressions”窗口

图 3-25 显示输入电压和电流波形

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-27. 构建级别 3：Vref = 1.5 时的示波器屏幕截图 Ia 和 Va (120VRMS L-N)

硬件、软件、测试要求和测试结果 www.ti.com.cn

40 基于 Vienna 整流器的 10kW 三相功率因数校正参考设计 ZHCUCN4 – DECEMBER 2024
提交文档反馈

English Document: TIDUFB1
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUCN4
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUCN4&partnum=TIDA-010257
https://www.ti.com/lit/pdf/TIDUFB1


8. 要使系统安全停止，请将输入交流电压降至零，并且观察 guiVBus 变量也降至零。

9. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，使用工具栏上的 Halt 按钮 ( ) 或使用 Target > 

Halt 来暂停处理器。接着，点击  按钮，使 MCU 退出实时模式。最后，将 MCU 复位 ( )。
10. 点击 Terminate Debug Session (Target > Terminate all)，关闭 CCS 调试会话。

3.2.2.4.4 INCR_BUILD 4：闭合平衡、电压和电流环路

在该编译版本中，电路板作为三线系统运行，即电源的中性点未连接到输出的直流中点。如图 3-28 中所示，为了

使直流母线保持平衡，在控制结构中添加了一个具有简单比例增益的平衡环路。在该生成中，还执行了第三个谐

波注入，这可以帮助稳定直流母线平衡点。
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图 3-28. 构建级别 4 控制图：输出电压、电感器电流和总线电容平衡环路
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3.2.2.4.4.1 编译和加载项目以及设置调试

1. 打开 vienna_settings.h 文件，将 VIENNA_INCR_BUILD 设置为 4，并将 

VIENNA_VBUS_REF_SET_VOLTS 设置为 650。
2. 右键点击项目名称，然后点击 Rebuild Project。这将成功编译项目。点击 Run → Debug；这将启动调试会

话。对于双 CPU 器件，如果出现一个窗口，指示必须选择一个 CPU，则执行调试。在本例中，选择

“CPU1”。然后项目加载到器件上，同时 CCS 调试视图变为有效状态。代码在主例程开始时停止。

3. 如需在“Watch”或“Expressions”窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台

对话框。在该控制台的右上角，点击“Open”以浏览到位于项目文件夹内的 setupdebugenv_build4.js 
脚本文件。该文件使用调试系统所需的合适变量来填充 Watch 窗口。点击 Watch 窗口中的 Continuous 

Refresh 按钮 ( )，以启用持续更新控制器中的值。图 3-29 展示了 Watch 窗口。

图 3-29. 构建级别 4：“Expressions”视图

4. 通过将鼠标悬停在水平工具栏中的按钮上并点击  按钮来启用实时模式。
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3.2.2.4.4.2 运行代码（版本 4）

1. 点击  按钮运行项目。

2. 将交流输入增大至 120VRMS VL-L 和 208VRMS VL-L，50/60Hz。图 3-30 显示了将从输入汲取的整流电流。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-30. 构建级别 4：PWM 跳闸时的示波器屏幕截图 Ia 和 Va (120VRMS L-N)
3. 总线电压通过 vBusRef 变量设置，已经是大约 1.55V，在该设计中该值对应于 650V。
4. 通过向 clearTrip 变量写入 1 来启动 PFC 操作。

5. 电路板现在会绘制正弦电流。图 3-31 显示了示波器屏幕截图。
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• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH3（粉色）：IGBT 栅极电压

• CH4（绿色）：交流输入 A 相电流

图 3-31. 构建级别 4：完整 PFC 时的示波器屏幕截图 Ia 和 Va (120VRMS L-N)
6. 检查“Expressions”窗口，如图 3-32 中所示。直流母线电压也将得到平衡，即 guiVbusPM 和 guiVbusMN 

变量几乎是相等的，这表明闭环平衡控制器正常工作。

图 3-32. 构建级别 4：120VAC 和 650VDC 时的“Expressions”窗口

硬件、软件、测试要求和测试结果 www.ti.com.cn

44 基于 Vienna 整流器的 10kW 三相功率因数校正参考设计 ZHCUCN4 – DECEMBER 2024
提交文档反馈

English Document: TIDUFB1
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUCN4
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUCN4&partnum=TIDA-010257
https://www.ti.com/lit/pdf/TIDUFB1


7. 平衡环路开环增益通过变量 Gs_GainKp 进行控制，并且可以在带宽不够时进行调节。不过，对于平衡环路，
带宽需要低于外侧电压环路，仅 1Hz 至 2Hz 带宽就足够了。

8. 要使系统安全停止，请将输入交流电压降至零，并且观察 guiVBus 变量也降至零。

9. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，使用工具栏上的 Halt 按钮 ( ) 或使用 Target → 

Halt 来暂停处理器。然后点击  按钮，使 MCU 退出实时模式。最后，选择  按钮以对 MCU 进行复

位。
10. 点击 Terminate Debug Session (Target > Terminate all)，关闭 CCS 调试会话。

.
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3.3 测试结果

节 3.3.1 至节 3.3.11 显示了测试结果，包括电流和电压波形以及热性能。

3.3.1 IGBT 栅极上升和下降时间

UCC5350MC 是一款 10A 栅极驱动器，该器件可以非常快速地驱动 IGBT 栅极，这有助于减少 IGBT 的功率损

耗。图 3-33 显示了 IGBT 栅极电压的上升时间为 200ns，下降时间为 120ns。

• CH3（粉色）：IGBT 栅极电压

图 3-33. IGBT 栅极上升沿

图 3-34 显示了 IGBT 栅极电压下降时间约为 120ns。

• CH3（粉色）：IGBT 栅极电压

图 3-34. IGBT 栅极下降沿
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3.3.2 上电序列

上电后，电解电容器（C15、C16、C24 和 C25）的充电电流受 PTC RT1 限制。一旦直流母线电压足够高，辅助

电源和隔离式电源就会开始工作，提供低压电源轨以让芯片工作。LED 指示灯也开始闪烁，继电器在延迟时间过

后接合。确保电路板上电时的直流负载小于 800Ω，否则 RT1 会被大浪涌电流触发。图 3-35 展示了 380VAC 下
电路板上电的波形。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-35. 上电序列

总上电时间，包括直流母线电解电容器充电时间、辅助电源启动时间、MCU 复位、继电器关闭延迟。图 3-36 显
示了在 380VAC 输入下上电时间约为 4 秒。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-36. 上电时间
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3.3.3 通过 GUI 启动的 PFC

上电后，直流母线电压约为 530VDC，一旦 PFC 启动，直流母线电压约为 680VDC。图 3-37 显示了使用 GUI 命
令 0x11 启动 PFC 时的波形。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-37. 通过 GUI 启动的 PFC

当 PFC 启动时，直流母线在空载下从大约 530V 上升到大约 680VDC。图 3-38 显示上升时间约为 55ms。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-38. PFC 启动时的直流母线上升时间
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3.3.4 380VAC、9kW 下的过零

图 3-39 展示了交流输入电压和电流的过零时间彼此匹配。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-39. 380VAC、9kW 下的过零时间

3.3.5 380VAC、10kW 下的电流纹波

图 3-40 展示了 380VAC、10kW 下的 6.8A 升压电感器电流纹波，其约为交流输入电流 21.9A 峰值的 ±15.5%。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-40. 380VAC、10kW 下的电流纹波
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3.3.6 使用电网电源进行 10kW 负载测试

图 3-41 展示了使用电网电源时 10kW 下的负载测试波形。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-41. 使用电网电源进行 10kW 负载测试

3.3.7 使用交流电源进行 9kW 负载测试

图 3-42 展示了使用交流电源进行的 9kW 负载测试。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-42. 使用交流电源进行 9kW 负载测试
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3.3.8 功率分析仪结果

图 3-43 展示了使用电网电源时 10kW 下的功率分析仪结果。

图 3-43. 使用电网电源时 10kW 下的功率分析仪结果

图 3-44 展示了使用交流电源时 9kW 下的功率分析仪结果。

图 3-44. 使用交流电源时 9kW 下的功率分析仪结果
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3.3.9 热性能

图 3-45 展示了在没有冷却风扇的开放式区域中，10kW 负载和 25°C 环境温度下的热性能。最高温升出现在 

MOSFET Q8，约为 55°C。对于辅助电源，升压电感器温升约为 23°C，IGBT 温升约为 40°C。

功率器件的温度和散热器温度也可以从图 3-3 中所示的 GUI 软件中读取。

图 3-45. 热性能

3.3.10 电压短路中断测试

图 3-46、图 3-47 和图 3-48 显示了在 5kW 下以 90、0 和 45 相位角进行的电压短路中断测试。升压电感器上的电

流由 DSP 内部 CMPSS 监控，如果此电流过大，在每个 PWM 周期中 IGBT 都会关断。这是逐周期保护。但是，
DSP 无法保护二极管电桥上的电流，因为当 IGBT 关闭时，二极管电桥上仍然存在不受控制的整流电流。

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-46. 90 相位角时的电压短路中断测试

硬件、软件、测试要求和测试结果 www.ti.com.cn

52 基于 Vienna 整流器的 10kW 三相功率因数校正参考设计 ZHCUCN4 – DECEMBER 2024
提交文档反馈

English Document: TIDUFB1
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUCN4
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUCN4&partnum=TIDA-010257
https://www.ti.com/lit/pdf/TIDUFB1


• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-47. 0 相位角时的电压短路中断测试

• CH1（蓝色）：DCBUS 输出电压

• CH2（浅蓝色）：交流输入 A 相电压

• CH4（绿色）：交流输入 A 相电流

图 3-48. 45 相位角时的电压短路中断测试
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3.3.11 效率、iTHD 和功率因数结果

图 3-49 展示了 325VAC、380VAC 和 400VAC 下每个功率级别的平均效率测试结果。在 380VAC 和 400VAC 
下，3kW 至 4.5kW 范围内的平均峰值效率为 98%。
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图 3-49. 效率结果

图 3-50 展示了 325VAC、380VAC 和 400VAC 下每个功率级别的平均 iTHD 测试结果。在 380VAC 下，在 2.5kW 
以上时平均 iTHD 低于 5%。在 380VAC 下，在 10kW 时 iTHD 低于 1.5%。
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图 3-50. iTHD 测试结果
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图 3-51 展示了 325VAC、380VAC 和 400VAC 下每个功率级别的平均功率因数测试结果。
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图 3-51. 功率因数测试结果
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4 设计和文档支持

4.1 设计文件

4.1.1 原理图

要下载原理图，请参阅 TIDA-010257 中的设计文件。

4.1.2 物料清单 (BOM)

若要下载 BOM，请参阅 TIDA-010257 中的设计文件。

4.2 工具与软件

工具

LAUNCHXL-F2800137 适用于 C2000™ 实时 MCU 的 TMS320F2800137 LaunchPad™ 开发套件

软件

C2000Ware DigitalPower SDK 适用于 C2000™ MCU 的 DigitalPower 软件开发套件 (SDK)。

4.3 文档支持

1. 德州仪器 (TI)，TMS320F280013x 微控制器数据表
2. 德州仪器 (TI)，TMS320F280013x 实时微控制器技术参考手册
3. 德州仪器 (TI)，C2000™ 软件频率响应分析仪 (SFRA) 库和补偿设计器用户指南

4.4 支持资源

TI E2E™ 中文支持论坛是工程师的重要参考资料，可直接从专家处获得快速、经过验证的解答和设计帮助。搜索

现有解答或提出自己的问题，获得所需的快速设计帮助。

链接的内容由各个贡献者“按原样”提供。这些内容并不构成 TI 技术规范，并且不一定反映 TI 的观点；请参阅 

TI 的使用条款。

4.5 商标

C2000™, TI E2E™, and Code Composer Studio™ (CCS) 集成开发环境 (IDE)™ are trademarks of Texas 
Instruments.
所有商标均为其各自所有者的财产。

5 作者简介

HELY ZHANG 是德州仪器 (TI) 的系统应用工程师，负责开发与家用电器相关的电力输送器件和电机逆变器。Hely 
于 2002 年获得了安徽理工大学电力电子专业硕士学位，在加入 TI 之前他曾就职于 SolarEdge 和通用电气。

JIM CHEN 是德州仪器 (TI) 的系统工程师，负责为家用电器指定并开发系统设计。Jim 于 2022 年获得了南京航空

航天大学的电气工程硕士学位。
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重要通知和免责声明
TI“按原样”提供技术和可靠性数据（包括数据表）、设计资源（包括参考设计）、应用或其他设计建议、网络工具、安全信息和其他资源，
不保证没有瑕疵且不做出任何明示或暗示的担保，包括但不限于对适销性、某特定用途方面的适用性或不侵犯任何第三方知识产权的暗示担
保。
这些资源可供使用 TI 产品进行设计的熟练开发人员使用。您将自行承担以下全部责任：(1) 针对您的应用选择合适的 TI 产品，(2) 设计、验
证并测试您的应用，(3) 确保您的应用满足相应标准以及任何其他功能安全、信息安全、监管或其他要求。
这些资源如有变更，恕不另行通知。TI 授权您仅可将这些资源用于研发本资源所述的 TI 产品的相关应用。 严禁以其他方式对这些资源进行
复制或展示。您无权使用任何其他 TI 知识产权或任何第三方知识产权。您应全额赔偿因在这些资源的使用中对 TI 及其代表造成的任何索
赔、损害、成本、损失和债务，TI 对此概不负责。
TI 提供的产品受 TI 的销售条款或 ti.com 上其他适用条款/TI 产品随附的其他适用条款的约束。TI 提供这些资源并不会扩展或以其他方式更改 
TI 针对 TI 产品发布的适用的担保或担保免责声明。
TI 反对并拒绝您可能提出的任何其他或不同的条款。IMPORTANT NOTICE

邮寄地址：Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
版权所有 © 2025，德州仪器 (TI) 公司
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